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Legal information
Warning notice system

This manual contains notices you have to observe in order to ensure your personal safety, as well as to prevent damage 
to property. The notices referring to your personal safety are highlighted in the manual by a safety alert symbol, notices 
referring only to property damage have no safety alert symbol. These notices shown below are graded according to 
the degree of danger.

DANGER
indicates that death or severe personal injury will result if proper precautions are not taken.

WARNING
indicates that death or severe personal injury may result if proper precautions are not taken.

CAUTION
indicates that minor personal injury can result if proper precautions are not taken.

NOTICE
indicates that property damage can result if proper precautions are not taken.
If more than one degree of danger is present, the warning notice representing the highest degree of danger will be 
used. A notice warning of injury to persons with a safety alert symbol may also include a warning relating to property 
damage.

Qualified Personnel
The product/system described in this documentation may be operated only by personnel qualified for the specific 
task in accordance with the relevant documentation, in particular its warning notices and safety instructions. 
Qualified personnel are those who, based on their training and experience, are capable of identifying risks and 
avoiding potential hazards when working with these products/systems.

Proper use of Siemens products
Note the following:

WARNING
Siemens products may only be used for the applications described in the catalog and in the relevant technical 
documentation. If products and components from other manufacturers are used, these must be recommended or 
approved by Siemens. Proper transport, storage, installation, assembly, commissioning, operation and maintenance 
are required to ensure that the products operate safely and without any problems. The permissible ambient 
conditions must be complied with. The information in the relevant documentation must be observed.

Trademarks
All names identified by ® are registered trademarks of Siemens AG. The remaining trademarks in this publication may 
be trademarks whose use by third parties for their own purposes could violate the rights of the owner.

Disclaimer of Liability
We have reviewed the contents of this publication to ensure consistency with the hardware and software described. 
Since variance cannot be precluded entirely, we cannot guarantee full consistency.  However, the information in this 
publication is reviewed regularly and any necessary corrections are included in subsequent editions.

Siemens AG
Digital Industries
Postfach 48 48
90026 NÜRNBERG
GERMANY

Document order number: A5E41425845
Ⓟ 05/2022 Subject to change

Copyright © Siemens AG 2022.
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Introduction 1
1.1 Purpose of this documentation

These instructions contain all information required to commission and use the device. Read the 
instructions carefully prior to installation and commissioning. In order to use the device 
correctly, first review its principle of operation.
The instructions are aimed at persons mechanically installing the device, connecting it 
electronically, configuring the parameters and commissioning it, as well as service and 
maintenance engineers.

1.2 Product compatibility

Edition Remarks Device revision Compatible device revision integration package
05/2022 Firmware up‐

date
Modbus
FW: 2.01.00-04
HW: 3.00.02 or later

SIMATIC PDM V8.2 SP1 or later EDD: 1.00.00 or later

09/2017 First edition Modbus
FW: 2.01.00-04
HW: 3.00.02 or later

SIMATIC PDM V8.2 SP1 or later EDD: 1.00.00 or later

1.3 Document history
The following table shows the most important changes in the documentation compared to each 
previous edition.  

Edition Note
05/2022 Firmware update,  corrections regarding pulse output
09/2017 First edition
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1.4 Device documentation package
The user documentation package for this product includes the following documents:

Document Purpose Intended users Availability
Operating Instruc‐
tions

Contains all information needed to 
• check and identify the delivered package
• install and electrically connect the prod‐

uct
• commission the product, (setting pa‐

rameters via HMI menu)
• operate and maintain the device on a 

daily basis
• troubleshoot and remedy minor opera‐

tion interruptions

Instrument techni‐
cians, plant opera‐
tors

• Available for download from 
homepage

• Hardcopy can be purchased 
via PIA Life Cycle Portal (only 
English and German ver‐
sions)

1.5 Items supplied
The device is delivered as:

Wall mount enclosure
• FST020 transmitter wall mount enclosure
• Siemens Process Instrumentation disk con‐

taining certificates and manuals.

Note
Supplementary information
Supplementary product and production specific certificates are included on the SensorFlash® SD 
card in the transmitter socket. 

Note
Scope of delivery may vary, depending on version and add-ons. Make sure the scope of delivery 
and the information on the nameplate correspond to your order and the delivery note.

Introduction
1.5 Items supplied
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1.6 Checking the consignment
1. Check the packaging and the delivered items for visible damages.
2. Report any claims for damages immediately to the shipping company.
3. Retain damaged parts for clarification.
4. Check the scope of delivery by comparing your order to the shipping documents for 

correctness and completeness.  
WARNING

Using a damaged or incomplete device
Risk of explosion in hazardous areas.
• Do not use damaged or incomplete devices.

1.7 Security information
Siemens provides products and solutions with industrial security functions that support the 
secure operation of plants, systems, machines and networks.
In order to protect plants, systems, machines and networks against cyber threats, it is necessary 
to implement – and continuously maintain – a holistic, state-of-the-art industrial security 
concept. Siemens’ products and solutions constitute one element of such a concept.
Customers are responsible for preventing unauthorized access to their plants, systems, 
machines and networks. Such systems, machines and components should only be connected to 
an enterprise network or the internet if and to the extent such a connection is necessary and only 
when appropriate security measures (e.g. firewalls and/or network segmentation) are in place.
For additional information on industrial security measures that may be implemented, please 
visit 
https://www.siemens.com/industrialsecurity. 
Siemens’ products and solutions undergo continuous development to make them more secure. 
Siemens strongly recommends that product updates are applied as soon as they are available 
and that the latest product versions are used. Use of product versions that are no longer 
supported, and failure to apply the latest updates may increase customer’s exposure to cyber 
threats.
To stay informed about product updates, subscribe to the Siemens Industrial Security RSS Feed 
under 
https://www.siemens.com/cert. 

Introduction
1.7 Security information
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1.8 Transportation and storage
To guarantee sufficient protection during transport and storage, observe the following:
• Keep the original packaging for subsequent transportation.
• Devices/replacement parts should be returned in their original packaging.
• If the original packaging is no longer available, ensure that all shipments are properly 

packaged to provide sufficient protection during transport. Siemens cannot assume liability 
for any costs associated with transportation damages.
NOTICE
Insufficient protection during storage
The packaging only provides limited protection against moisture and infiltration.
• Provide additional packaging as necessary.

Special conditions for storage and transportation of the device are listed in Technical 
specifications (Page 77).

Identification   

Note
IMPORTANT
This device is NOT to be used in hazardous areas.
CE declaration is delivered with the device.

Transmitter model number is: FST020
The system ordering code represents the transmitter including accessories.
AC System ordering code: 7ME3570-1JA4XXXXXX
DC System ordering code: 7ME3570-1JB4XXXXXX
AC - Transmitter ordering code: 7ME3570 - 1JA40-0AA1
DC - Transmitter ordering code: 7ME3570 - 1JB40-0AA1

1.9 Further Information

Product information on the Internet     
The Operating Instructions are available on the documentation disk shipped with the device, 
and on the Internet on the Siemens homepage, where further information on the range of 
SITRANS F flowmeters may also be found:
Product information on the internet (http://www.siemens.com/flow) 

Introduction
1.9 Further Information
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Worldwide contact person   
If you need more information or have particular problems not covered sufficiently by these 
Operating Instructions, get in touch with your contact person. You can find contact information 
for your local contact person on the Internet:
Local contact person (http://www.automation.siemens.com/partner) 

1.10 Notes on warranty
The contents of this manual shall not become part of or modify any prior or existing agreement, 
commitment or legal relationship. The sales contract contains all obligations on the part of 
Siemens as well as the complete and solely applicable warranty conditions. Any statements 
regarding device versions described in the manual do not create new warranties or modify the 
existing warranty.
The content reflects the technical status at the time of publishing. Siemens reserves the right to 
make technical changes in the course of further development.

Introduction
1.10 Notes on warranty
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Safety notes 2
2.1 Precondition for use

This device left the factory in good working condition. In order to maintain this status and to 
ensure safe operation of the device, observe these instructions and all the specifications relevant 
to safety.
Observe the information and symbols on the device. Do not remove any information or symbols 
from the device. Always keep the information and symbols in a completely legible state.

2.2 Warning symbols on the device
Symbol Explanation

Caution. The Caution symbol is used throughout the operating instructions.

     

2.3 Laws and directives
Observe the safety rules, provisions and laws applicable in your country during connection, 
assembly and operation. These include, for example:     
• National Electrical Code (NEC - NFPA 70) (USA)
• Canadian Electrical Code (CEC) (Canada)
For CE marked equipment the device complies with the following directives:
• Low voltage directive LVD 2014/35/EU
• EMC directive 2014/35/EU
• Restriction of hazardous substances directive 2011/65/EC and 2015/863/EU

SITRANS FST020 IP65 (NEMA 4X)
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2.4 Conformity with European directives
The CE marking on the device symbolizes the conformity with the following European directives:

Electromagnetic compatibil‐
ity EMC 
2014/30/EU

Directive of the European Parliament and of the Council on the 
harmonisation of the laws of the Member States relating to elec‐
tromagnetic compatibility

Low voltage directive LVD 
2014/35/EU

Directive of the European Parliament and of the Council on the 
harmonisation of the laws of the Member States relating to the 
making available on the market of electrical equipment designed 
for use within certain voltage limits

Restrictions on Hazardous 
Substances
RoHS 2011/65/EC and 
2015/863/EU

EU Directive: Restriction of Hazardous Substances in Electrical 
and Electronic Equipment Directive and Annex II Commission 
Delegated Directive 

The applicable directives can be found in the EU declaration of conformity of the specific device.

2.5 Lithium batteries
Lithium batteries are primary power sources with high energy content designed to represent the 
highest possible degree of safety.  

WARNING
Lithium batteries
Explosion Hazard - Can cause death or serious injury.
Lithium batteries may present an Explosion Hazard if they are abused electrically or 
mechanically. This is in most circumstances associated with the generation of excessive heat 
where internal pressure may cause the cell to rupture. 
Thus the following basic precautions should be observed when handling and using lithium 
batteries:
• Do not short-circuit, recharge or connect with false polarity.
• Do not expose to temperature beyond the specified temperature range or incinerate the 

battery.
• Do not crush, puncture or open cells or disassemble battery packs.
• Do not weld or solder to the battery’s body.
• Do not expose contents to water.

Safety notes
2.5 Lithium batteries
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Description 3
3.1 Overview

SITRANS FST020 ultrasonic flow meter systems consist of a transmitter and a sensor. The 
following table lists the available combinations of transmitters and sensors.

Transmitter Sensor type
FST020 FSS200 family

DN 15 to DN 10m (0.5" to 360")

3.2 Design
The transmitter reads the measured process values from the sensor and calculates derived 
values. It provides Modbus communications, 1x 4-20ma, 1x relay, and 1x Pulse/Frequency, USB 
service port, and a local display. It also adds functionalities such as totalizers, access control, 
diagnostics, and configuration. The local user interface consists of a display and four buttons for 
user interaction.
The transmitter has a modular design with discrete, replaceable electronic modules and 
connection boards to maintain separation between functions and facilitate field service. All 
modules are fully traceable and their provenance is included in the transmitter setup.
The SITRANS FST020 is available as:

Wall mount housings: AC and DC

Figure 3-1 DC Wall Mount housing shown
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Pipe mount kit
The Pipe kit is CQO:1012NMB-1.

Figure 3-2 Pipe Mounting shown with mounting plate

3.3 Features
• Wall mount IP65 enclosure
• Full graphical local display
• SensorFlash (SD card) for memory backup, Datalogger and documentation storage 

(certificates etc.)
• USB service interface
• Modbus communications
• One pulse/frequency output
• One relay
• One current output 4-20 mA
• High immunity against process noise
• Fast response to step changes in flow
• High update rate (100 Hz) on all process values

Description
3.3 Features
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• Measurement of:
– Volume flow
– Mass flow (with fixed density setpoint)
– Flow velocity
– Sound velocity

• Configurable upper and lower alarms and warning limits for nearly all process values
• Independent low flow cut-off settings for volume flow and mass flow
• Zero-point adjustment (initiated by host system)
• Process noise damping using digital signal processing (DSP)
• Simulation of process values
• Simulation of all outputs
• Simulation of alarms
• Enabling alarms for visibility on all outputs (HMI, status and communication)
• Comprehensive diagnostics (Siemens standard) for troubleshooting and sensor checking
• Firmware update
• Data logging in SensorFlash
• Peak indicators
• Alarm delay

Description
3.3 Features
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Installing/mounting 4
4.1 Chapter overview (transmitter)

This chapter describes how to install the wall mount housing transmitter.

Wall mount housing
The wall mount housing transmitter can be mounted either on a wall or on a pipe (with optional 
pipe mount bracket), see Installation instructions (Page 20).

4.2 Installation location requirements

4.2.1 Environment
SITRANS F flowmeters with minimum IP65/NEMA 4X enclosure rating are suitable for indoor and 
outdoor installations.

Process pressure and medium temperature
If applicable, make sure that specifications for rated medium temperature (TS) plus ambient 
temperature that are indicated on the device nameplate / label will not be exceeded.  

Aggressive atmospheres
Ensure that the device is suitable for the application and that it is installed where there is no risk 
of penetration of aggressive vapors.

Direct sunlight
Prevent the device from overheating or materials becoming brittle due to UV exposure by 
protecting it from direct sunlight. Make sure that the maximum permissible ambient 
temperature is not exceeded. Refer to the information in Technical specifications (Page 77).

WARNING
Electrical shock hazard
May cause death or serious injury
Disconnect power before working on this product.

Upstream / Downstream
Avoid long drop lines downstream from the sensor to prevent the meter pipe from draining. 
Avoid installing the sensor upstream of a free discharge in a drop line where possible.

SITRANS FST020 IP65 (NEMA 4X)
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Sensor Location in piping system
The optimum location in the system depends on the presence of excessive gas or air bubbles in 
the fluid may result in erroneous measurements. Therefore, it is preferred not to install the 
sensor at the highest point in the system, where gas / air bubbles will be trapped. For liquids it 
is advantageous to install the sensor in low pipeline sections, at the bottom of a U-section in the 
pipeline.

4.2.2 Normal environmental conditions
Normal environmental conditions
This standard applies to equipment designed to be safe at least under the following conditions:
• Indoor and outdoor use
• Altitude up to 2000 m 
• Operating temperature -10 °C to 50 °C (14 °F to 122 °F)
• Maximum relative humidity 80 % for temperatures up to 31 °C decreasing linearly to 50 % 

relative humidity at 40 °C (104 °F) 
• Mains supply voltage fluctuations up to ±10 % of the nominal voltage
• Transient Overvoltages up to the levels of Overvoltage Category II
• Temporary Overvoltages occurring on the Mains supply.
• Pollution Degree II

4.3 Installation instructions

4.3.1 Wall mount transmitter

Wall mounting

WARNING
Hazardous voltage
May cause death or serious injury
Disconnect power before working on this device.

The transmitter can be mounted on any wall surface including wood, metal or concrete. Use the 
appropriate bolts and screws as needed for your mounting application and adhere to local codes.

Installing/mounting
4.3 Installation instructions
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Prepare holes for the four screws (M6x100 or equivalent). Screw head diameter: max. 13.5 mm; 
screw shaft diameter: max. 6 mm.
• Recommended mounting: Directly to wall or to electrical cabinet back panel.
• If alternate mounting surface is used it MUST support four times the weight of the unit.

Mounting the enclosure
1. Loosen the enclosure cover screws and open the cover to reveal the mounting holes.
2. Mark and drill four holes in the mounting surface for four mounting screws (supplied).
3. Using a long flat-blade screw driver, mount transmitter and tighten screws.
4. Tighten nuts (torque: 10 Nm).
5. Refer to Connecting the power supply (Page 28) and Sensor connections  (Page 28)  to 

complete installation.

Figure 4-1 Wall mounted transmitter showing mounting hole pattern

Mounting on pipe

Note
Mounting on pipe
For mounting on pipe, see the installation instructions given in the CQO:1012NMB-1 
instructions that are provided with the optional mounting bracket kit.
U-bolts and other miscellaneous hardware are not supplied with the flowmeter. 

Installing/mounting
4.3 Installation instructions
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For installation on 2-inch standpipe use the optional CQO:1012NMB pipe mounting kit.

Table 4-1 CQO:1012NMB-1 Mounting Kit
Description Qty
Mounting Plate 1
U-Bolt Assembly including bracket and nuts 2
8-32 x 5/8 LG cross round head screws 4
#8 Flat washer 4
#8 Split lock washers 4
8-32 Hex nut 4

1. Affix mounting plate to standpipe using the U-bolt assemblies.
2. Secure transmitter to mounting plate using #8-32 screws, washers and nuts.
3. Tighten nuts (torque: 10 Nm).
4. Refer to Connecting the power supply (Page 28) and Sensor connections (Page 28) to 

complete installation.
Note
Use conduit fittings or cable glands on all cables.

Installing/mounting
4.3 Installation instructions
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① Mounting plate
② Stand pipe
③ Mounting hardware (see table above)
④ U-bolt assembly

Installing/mounting
4.3 Installation instructions
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Connecting 5
This chapter describes how to wire up the transmitter for operation with a sensor.
• Transmitter power supply, communications and I/O connections (Page 28)  
• Sensor connections (Page 28)
• Connecting the power supply (Page 28) 
• Connecting Inputs/Outputs (Page 30)
• Connecting channel 1 (Page 31) (Modbus communication channel)
For connection of the sensor, see the relevant sensor Installation Manual.

5.1 Basic safety notes

5.1.1 Missing PE/ground connection

WARNING
Missing PE/ground connection
Risk of electric shock. May cause death or serious injury.
Depending on the device version, connect the power supply as follows:
• Power plug: Ensure that the used socket has a PE/ground conductor connection. Check that 

the PE/ground conductor connection of the socket and power plug match each other.
• Connecting terminals: Connect the terminals according to the terminal connection 

diagram. First connect the PE/ground conductor.

5.1.2 Energized devices

WARNING
Energized devices
Risk of electric shock. May cause death or serious injury.
When energized the device may be opened by qualified personnel only.
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WARNING
Mains supply from building installation overvoltage category 2
A circuit breaker (max. 15 A) must be installed in close proximity to the equipment and within 
easy reach of the operator. It must be marked as the disconnecting device for the equipment.

WARNING
DC connection devices
The DC power source must be isolated from mains supply.

5.2 Disconnecting device

Overvoltage Category II
Connect mains supply through a circuit breaker (max. 15 A) in close proximity to the transmitter 
and within easy reach of the operator. Mark it as the disconnecting device for the transmitter.

5.3 Device nameplates
Each part of the system has one nameplate type showing the following information:
• product identification
• product specifications
• certificates and approvals

Note
Identification
Identify your device by comparing your ordering data with the information on the product 
and specification nameplates.

The transmitter is identified as "Ultrasonic transmitter SITRANS FST020" and the sensor as 
"Ultrasonic sensor SITRANS FSS200". 
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5.3.1 Device nameplate

Transmitter nameplates

① Product name Transmitter product name
② System order no. Device-specific system order number (transmitter and sensor)
③ Transmitter order no. Transmitter replacement order numbers
④ Serial no. Transmitter serial number
⑤ System revisions System revision numbers; firmware (FW) and hardware (HW)
⑥ Power Supply Power supplies: AC and DC
⑦ Enclosure IP Degree of protection
⑧ Operating temperature Operating temperature of the device
⑨ Agency marking Specific agency identification marking
⑩ Data matrix code Product-specific QR-code
⑪ Contact information ad‐

dress
Contact address for device information

⑫ Place of manufacture Device place of manufacture
⑬ Year of Manufacture Manufacturing year. More detailed manufacturing date information is given in the serial 

number (see sensor identification nameplate above)
⑭ WEEE symbol, see Disposal (Page 71)
⑮ Caution symbol
⑯ CE CE mark

Figure 5-1 Transmitter Labels: AC-DC
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5.4 Transmitter power supply, communications and I/O connections

5.4.1 Sensor connections
For sensor connection, see the FSS200 Sensor installation instructions manual.

5.4.2 Connecting the power supply

Note
If the transmitter is not already mounted and cabling has not been run, proceed to Mounting the 
Transmitter (Page 20) before connecting power.

WARNING
Hazardous Voltage
May cause death or serious personal injury.
Disconnect power before working on this product.

1. Using a flat-head screwdriver, loosen the six securing screws from the Keypad Enclosure 
Cover and open cover.

2. To determine type of power connection refer to the following part numbers:
– 7ME3570-1HA4 = AC Power (with 500mA fuse)
– 7ME3570-1HB4 = DC Power (with 2A fuse)

3. Remove input power blind plug and fit cable gland.
4. Push cable through open gland and cable path.
5. Loosen power plug connector screws.
6. Referring to the illustration and table below, as per local electric codes, wire input power 

connector for AC or DC power depending on power supply provided.

Connector pins AC DC Wire color
1 L1 + Black
2 L2N - White
3 Ground Ground Green

Connecting
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7. Insert AC or DC power wires into wire entry holes and secure by tightening wire clamp screws 
using a screwdriver.
– For AC - Connect ground to terminal  and power to terminals L1 and L2N.
– For DC - Connect ground to terminal  and power to terminals + and -.

Note
Power supply connector wires should be stripped stranded or solid conductors AWG 12-18.

11.5-28VDC

① Power input (AC or DC - see inserts) ⑥ Relay
② I/O terminals TB1 ⑦ 4-20 mA
③ Modbus ⑧ I/O input cable - 30m (98ft) max length
④ Totalizer ⑨ Power input cable
⑤ Pulse ⑩ Sensor cables - 90m (300 ft) max length

Figure 5-2 Input Power Wiring
8. Plug power connector into jack.
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9. Tighten cable gland.
10.Connect the power cable to the appropriate power source (100-240 VAC @ 50/60 Hz or 

11.5-28.5 VDC) and power up unit.
WARNING

Circuit limited to 15 Amps
The branch circuit must be limited to 15A or damage to the unit and death or serious injury 
may result.
It is recommended that the circuit breaker be located near the transmitter.

5.4.3 Connecting Inputs/Outputs
1. Remove blind plugs where required from the flowmeter case.
2. Loosen spring screws on housing lid.
3. Open housing lid.

A label showing the device configuration is placed on the PC board inside the transmitter 
housing. It is either for AC or DC power depending on the flowmeter type.

Figure 5-3 Inside cover - AC and DC labels
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5.4.4 Connection Wiring
Terminal Block Wiring
These connection diagrams apply to the part numbers listed below.

SITRANS FST020
FST020 7ME3570..._...

Figure 5-4 Terminal board channels and pin numbers

Note
4 to 20 mA current output Channel 2
It is not required to use shielded cables for the pure 4 to 20 mA current output.

Table 5-1 Input/Output Wiring
Pin# Signal Function Description

1 Io1+ Isolated Loop Supply Spannable 4-20mA output (Loop Powered) This 
output also provides a fault indication by drop‐
ping to 2mA if assigned to flow rate and under 
fault conditions.

2 Io1- Isolated Loop Return

3 Chassis Ground Ground
4 C Common Relay Output
5 NO Normally Open Relay Output
6 NC Normally Closed Relay Output
7 Chassis Ground Ground
8 PULSE OUTPUT + Transistor Menu selection: PGEN, POS TOTAL, NEG TOTAL
9 PULSE OUTPUT - Transistor
10 Chassis Ground Ground
11 NO TOT + DIGITAL INPUT + Freezes Totalizer to stop incrementing. 
12 NO TOT - DIGITAL INPUT -
13 CLR TOT + DIGITAL INPUT + Clears Totalizer 
14 CLR TOT - DIGITAL INPUT -
15 Modbus_B Differential + Serial communication, Modbus protocol
16 Modbus _A Differential - Serial communication, Modbus protocol
17 Chassis Ground Ground
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Wiring

W

W

W

*

 

① 4 - 20mA output (current source) ④ Digital input (Freeze TOT)
② Relay output ⑤ Digital input (CLR TOT)
③ Pulse output ⑥ Modbus

Figure 5-5 Typical FST020 Wiring

Connect pulse output to galvanically isolated input

Figure 5-6 Alternative pulse output connection with galvanically isolated input
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If the input is galvanically isolated the polarity does not need to be inverted.

Isolated 4-20mA Output TB1-1/2
R = 250 Ω typical, 750 Ω maximum
Vc = 24 VDC typical / 30 VDC maximum
I = 4-20mA
RL = Loop wire resistance (both ways) plus User's input load resistance.

Pulse output TB1-8 / TB1-9
Vc = +30 VDC max.
RL = 3K Ω minimum

Digital Inputs TB1-11 / TB1-12 and TB1-13 / TB1-14
Vc = (10V + 0.02 x RL) max. 2 ≤ Vc ≤ 30 VDC
0 ≤ RL ≤ 1000 Ω  

Activate or deactivate digital input on channel 7 (freeze totalizer) or channel 8 (clear totalizer)
1. Apply voltage VC according to your wiring to activate function on channel 7 or channel 8.
2. Apply short circuit between pins to deactivate function.

See also
Connecting Inputs/Outputs (Page 30)

5.4.5 Finishing the transmitter connection (wall mount housing)

Connection check-up
1. Check individual wire and cable installations by tugging firmly.
2. Firmly tighten cable glands and insert blanking plugs in unused cable entries.
3. Close flowmeter cover.
4. Tighten the six cover securing spring screws.
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Commissioning 6
This chapter gives instructions to commissioning your device, see Commissioning via local 
display (Page 37).
Furthermore, the device can be commissioned using SIMATIC PDM, see Commissioning with 
SIMATIC PDM (Page 101).

6.1 Basic Safety notes

WARNING
Loss of type of protection
Risk of explosion. Damage to device if the enclosure is open or not properly closed. The type of 
protection specified on the nameplate or in Technical specifications (Page 77) is no longer 
guaranteed.
• Make sure that the device is securely closed.

WARNING
Hot surfaces
Risk of burns resulting from hot surfaces.
• Take corresponding protective measures, for example by wearing protective gloves.

6.1.1 Hazardous contact voltage

WARNING
Hazardous contact voltage
May cause death or serious injury.
Risk of injury through hazardous contact voltage when the device is open or not completely 
closed. 
The degree of protection specified on the nameplate or in Technical data  (Page 77)is no 
longer guaranteed if the device is open or not properly closed.
• Make sure that the device is securely closed.
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6.2 General requirements
Before commissioning it must be checked that:
• The device has been installed and connected in accordance with the guidelines provided 

in Installing/mounting (Page 19) and Connecting (Page 25).

6.3 Power-up
Power up the device. Local display will show a screen for initial startup (Page 36).

6.4 Local display
The device is commissioned/operated with the touch keypad on the local display. 
The graphic display above the keypad gives a menu-guided operation of the individual device 
function/parameters. Successful operation of the key is confirmed by tactile feedback as key is 
pressed.

① Full graphical display
② Touch keypad

Figure 6-1 Local display

Note
HMI timeout
If no key is pressed for 10 minutes, the display switches to show operation view. If Backlight is 
set to Automatic, display backlight goes off automatically 30 seconds after the last key press.

6.5 Initial startup
The first time the device is powered up, you will be prompted to set the language. The device 
always starts up showing "Language" in English. When the language has been set, you will be 
prompted to set the date and time.
You will be asked if you want to start the "Quick commissioning" wizard. If you choose "Yes" 
(recommended), the "Quick commissioning" wizard will start. If you choose "No", you accept the 
default values of the device, and the next HMI view will be the operation view 1.

Commissioning
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Start

Language

Quick commissioning

Set date and time

No
Yes

Continue with Quick commissioning wizard

First startup wizard is now finished 

Welcome

6.6 Commissioning via local display

6.6.1 Chapter overview
In this chapter it is described how to commission the device via the local display using the Quick 
commissioning wizard.

6.6.2 Wizards

6.6.2.1 Quick Commissioning wizard (menu item 1.1)
The Quick commissioning wizard will guide you through configuration of parameters essential 
for your application. You configure parameters essential for your application by selecting the 
configuration path and sub-wizards appropriate for your application.

Commissioning
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6.6.2.2 Quick Commissioning wizard (wizard)
Start

Quick start

Quick commissioning

Sensor settings

Process values

Inputs and outputs

Copy configuration

Identification
Long tag

Location

Installation date

Next

Finished

Sensor settings

Process values

Inputs and outputs

Communication

Next

Basic configuration

Text Options/Description
Select a basic configura‐
tion wizard

Sensor settings, Process values, Inputs and outputs, Copy configuration

Set the identification pa‐
rameters

Long tag, Location, Installation date

The "Quick commissioning" wizard comprises the following subwizards:
• Sensor settings wizard (wizard) (Page 39)
• Process values wizard (wizard) (Page 44)
• Inputs/Outputs wizard (Page 45)
Each sub-wizard has its own view numbering. The sub-wizard name and the parameter name are 
shown in the upper left corner of the display. The view number and the total views in the sub-
wizard are shown in the upper right corner of the display.

6.6.2.3 Sensor settings wizard (menu item 1.2)
The Sensor settings wizard will guide you through configuration of essential parameters.
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6.6.2.4 Sensor settings wizard (wizard)

Units settings

No
Yes

Sensor settings (1)

Units settings 

Pipe settings

Text Options/Description
Unit settings Select "Yes" to configure the display units.
Unit settings Set the display units of length, temperature, pressure, kinematic viscosity, 

and density.
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Pipe settings 

Sensor settings (2)

Pipe class

Sensor settings

Pipe size

Outer diameter + wall thickness

Circumference + wall thickness

Outer pipe diameter

Wall thickness

Custom

Custom

Liner

Wall sound velocity

Yes
No

Liner material

Liner settings

Yes
No

Pipe circumference

Inner pipe roughness 1)

Select material

Disturbed flow 

Text Options/Description
Pipe settings Select "Yes" to configure the pipe.
Pipe class Select the pipe class.
Pipe size Select the pips size from the options available for the selected pipe class.
Pipe circumference Enter pipe circumference. Only available if custom pipe class is selected.
Outer pipe diameter Enter outer pipe diameter. Only available if custom pipe class is selected.
Wall thickness Enter wall thickness. Only available if custom pipe class is selected.
Select material Select the pipe material. 
Wall sound velocity Enter the wall sound velocity of the material. Only available if custom 

material is selected.
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Liner Select "Yes" to configure the liner material.
Select "No" to only configure the Inner pipe roughness.

Liner material Select the liner material.
Liner settings Set the liner sound velocity and thickness.
Disturbed flow Define the type of pipe configuration and the distance to the sensor.
Inner pipe roughness Set the inner pipe roughness.
* Select "Custom" to enter non-standard values.

Medium settings

Sensor size

No

Sensor setting (3)

Sensor settings 

Sensor selection

Sensor size

FSS200 high precision

FSS200 / 1011 universal

FSS200 / 991 high temperature

1011 high precision liquid

Sensor type

Yes

Text Options/Description
Sensor settings Select "Yes" to configure the sensors.
Sensor settings Select the sensor type installed (found on sensor label).
Sensor size Select the sensor size from the options list (found on sensor label).
Sensor selection Define the temperature compensation mode, the temperature class, the 

spacing offset and the cable length
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Medium settings

Path settings

Medium settings

Custom

Yes

Sensor settings (4)

Process parameters

No

Text Options/Description
Medium settings Select "Yes" to configure the medium.
Medium settings Select the process medium.
Process parameters Set the expected sound velocity (only available if custom process medium 

is selected) and the process temperature, pressure, kinetic viscosity, and 
density.
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Path settings

*

**

Finished

Path geometry

Path 1

Mounting path 1

Start measurement

Save settings

Installed paths

Yes

No

Sensor settings (5)

Text Options/Description
Path settings Select "YES" to configure the path(s).
Installed paths Select the paths installed.
Save settings Moves to the next menu item.
Start measurement * for each installed path. Select the path to configure.
Path geometry Define the geometry of the path (direct or reflect mode) 
Mounting path 1 Represents the spacing offset. Use Nom for most applications.
Path 1 Select "Receiver signal" to view graphical display of the receiver signal.

** Select "Next" to configure next path or to select "Next" to finish the 
wizard.

6.6.2.5 Process Values wizard (menu item 1.3)
The Process values wizard will guide you through setup of process values for your application. 
The prioritizing of the process values automatically configures the measurement views on the 
display. The process value configured as first process value is set as first display view.
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1

2

3

① Wizard name
② Step name / Parameter name
③ View number / Total views in wizard

6.6.2.6 Process values wizard (wizard)
Start

Prioritize

1st process value

2st process value

3st process value

4st process value

5st process value

6st process value

Next

Quick start

Quick commissioning

Sensor settings

Process values

Inputs and outputs

Copy configuration

Totalizers

Totalizer Totalizer

Process value

Mass flow

Volume flow

Standard volume flow*

Yes

No

Process value

Units

Direction

Fail-safe behavior

Next

Fail-safe behavior

Run

Hold

Memory

1st value

Volume flow

Mass flow

Flow velocity

Sound velocity

Density

Kinematic viscosity

Totalizer

Medium temperature

Units

process value

specific list

Finished

Units

Process value

specific list

Direction

Forward and backward

Forward

Backward

Hold
Activate totalizer view

Units

process value

specific list

Low flow cut-off

Next
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6.6.2.7 Inputs/Outputs wizard
The first screen in the Inputs and outputs wizard informs about the active/passive operation 
availability. It shows the application possibilities of your hardware. The kind of operation 
depends on the wiring.
The Inputs and outputs wizard will guide you through setup of inputs and outputs on the 
available channels.
Channel 2 - output
Channel 3 - relay
Channel 4 -input/output

6.6.3 Navigating the menu structure

6.6.3.1 Chapter overview
In this chapter it is described how to commission the device via the local display using the Quick 
commissioning wizard.

6.6.3.2 Navigation view
The exact structure of the operating menu is explained in HMI menu structure (Page 115).
All items of the menu structure of the device are identified with a unique number.
Level 1 of the menu structure is standardized for all Siemens Process Instrumentation devices 
and covers the following groups:
1. Quick start: Lists the most important parameters for quick configuration of the device. All 

parameters in this view can be found elsewhere in the menu.
2. Setup: Contains all parameters which are needed to configure the device.
3. Maintenance and diagnostics: Contains parameters which affect the product behavior 

regarding maintenance, diagnostics and service.
4. Communication: Contains parameters which describe the Modbus communication settings 

of the device.
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5. Security: Contains parameters which describe all security settings of the device.
6. Language: Parameter for changing the language of the local display. Regardless of the 

language setting, the term for this parameter is always the English term (Language).

1

2 3

45

① List of menu structure items
② Name of the previously selected item
③ Number of highlighted item
④ Alarm status text
⑤ Device status icon

Figure 6-2 Level 1 of the menu structure

6.6.3.3 Navigating the menu structure
You can navigate through the menu structure items in the device using the four buttons on the 
display as described below.

Table 6-1 Key functions - menu structure navigation
Key Function

Return to previous item.
Select the item above.
Select the item below.
Enter the selected item.
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Operating 7
These Operating Instructions describe the operation via the local display (HMI). The device can 
also be operated via various software.

7.1 Display views
There are six display views, all fully configurable. Use the  and the  keys to switch between 
the operator views,
Four different types of views are available:
• Display of measured process values, see Reading the process values (Page 49).
• Display for totalizer operation, see Operating the totalizer (Page 51).
• Display of a list of active alarms, see Handling alarms (Page 51).
• Display of six configurable measurement/diagnostic values, see Reading the diagnostic 

values (Page 53).

7.2 Access control
You can view all items in the HMI menu but the parameters are protected against changes 
through access level control. To gain access, select one of the following access levels:

• Read only
Allows no configuration. The parameter values can be viewed only (indicated by a  symbol). 
No PIN code required.

• User
Allows configuration and service of all parameters except calibration parameters. Default PIN 
code is 2457.

• Expert
Allows configuration and service of all parameters including flow and calibration parameters. 
Default PIN code is 2834.
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PIN codes can be changed in Security (5).

Note
Lost PIN code
If the PIN code is lost, provide Siemens customer support with the transmitter serial number (see 
nameplate). Siemens customer support will provide a code to be entered in PIN recovery (5.3).

Disable access level control
If logged in as Expert you can Deactivate user PIN. As User you will not be prompted to enter 
the password. Enabling the access level control can be done in Activate user PIN and requires 
entering the Expert password.

Auto logout function
You will not be prompted for password for 10 minutes after the last key press.

NOTICE
Device restart
Whenever the device is restarted, the access level is reset to Read only.

7.3 Operating the FST020

7.3.1 Fixed display texts
Some displayed texts are fixed, which means they will not change regardless of changed display 
language.
The following tables list the fixed display texts and their corresponding process value, diagnostic 
value, and compensation value names.

Table 7-1 Process values
Fixed display text Process value name
VOL.FLOW Volume flow
MASS FLOW Mass flow
FLOW VEL Flow velocity
SOUND VEL Sound velocity
DENSITY Density (Fixed value)
KIN. VISCOSITY Kinematic viscosity (Fixed value)
FLUID TEMP. Medium temperature (Fixed value
TOT1 Totalizer 1
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Table 7-2 Diagnostic values
Fixed display text Diagnostic value name
TRN TEMP. Transmitter internal temperature
CURR. OUT (CH2) Ch2 value
REYNOLDS NO. Reynolds number
P1.SNR UP SNR up path 1
P1.SNR DOWN SNR down path 1
P1.SOUND VEL Sound velocity path 1
P1.DELTA TIME Delta time path 1
P1.ACC.BURST Path 1 percentage of bursts accepted
P1.PEAK AMP.DN Peak amplitude down path 1
P1.PEAK AMP.UP Peak amplitude up path 1

7.3.2 Reading the process values
The value of the process values can be displayed either as one or more numeric values or as 
numeric value(s) in combination with a graph/bargraph. The following view types are available:
• Single value
• Three values
• Totalizer
• 1 value and graph
• 1 value and bargraph
• Six values

Table 7-3 Key functions - operator view
Key Function

No functionality
Go to the previous operator view
Go to the next operator view
Enter the menu structure access point

Single value
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Three values

1 value and bargraph

Note
Bargraphs
The bargraph limit values indicate the set lower and upper alarm limits, and the vertical lines in 
the bargraph indicate the set lower and upper warning limits. 

1 value and graph

Six values
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7.3.3 Operating the totalizer
When totalizer is displayed in the main view, press  to access the totalizer operation.

Table 7-4 Key functions - totalizer operation
Key Function

Exit totalizer operation
Select action to perform
Select action to perform
Perform selected action

7.3.4 Handling alarms
When the alarm list is displayed in the main view, press  to get more detailed information 
about the active alarms.
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Table 7-5 Key functions - alarms list view
Key Function

Exit alarm list view
Select the item above in the list; keep pressing the key to accelerate scrolling up the selec‐
tion list
Select the item below in the list; keep pressing the key to accelerate scrolling down the 
selection list
View more information on the selected alarm

2

Press  to exit the detailed alarm information.

Alarm acknowledgement
There are two ways to have the alarms removed from the alarm list.
• Manual: The alarm remains in the alarm list until the alarm is manually acknowledged (ack.). 

Before the alarm can be acknowledged, the cause must be eliminated. Press  to go to the 
detailed alarm information. Press  again to acknowledge the alarm. The time of the 
acknowledgement is shown in the history log.

• Auto: The alarm is removed from the alarm list when the cause is removed (going)
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7.3.5 Reading the diagnostic values
One of the main views can be configured to show six diagnostic values.

7.3.6 Reading / changing parameters

7.3.6.1 Parameter view introduction
Depending on your access level, you can read the current value and/or edit the value of the 
selected parameter.   

7.3.7 Alphanumeric parameters

Read only
The view shows the set value. Press  to exit the view.

Edit
Editable alphanumeric parameters are displayed as shown here. 
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Table 7-6 Key functions - editing alphanumeric values
Key Function

Select the next left position.
If the most left position is selected: exit the parameter edit view without confirming the 
changes. Keep pressing the key to jump to the most left position.
Change the selected number/character.
Numeric characters: increase the number by one (for example from 7 to 8)
ASCII characters: select the previous character in the alphabet.
Change the selected number/character.
Numeric characters: decrease the number by one (for example. from 8 to 7)
ASCII characters: select the next character in the alphabet.
Select the next right position.
If most right position is selected: confirm the change and exit the parameter edit view. Keep 
pressing the key to jump to the most right position.

Note
Ensure that the new value is within the minimum/maximum range when changing numeric 
values.

Note
##### signs in display
The display is unable to show the measured value or the value is missing or invalid. Try to fix by 
changing the measurement units or the resolution.

7.3.7.1 Changing the resolution

Changing the resolution
In order to change the resolution of the process value shown in the operation view (for example 
mass flow), set the decimal places parameter for the selected process value. For example, the 
decimal places for process value Mass flow is defined in Decimal places.
The resolution can also be changed by changing the resolution of one configuration parameter 
for this process value. For example Low flow cut-off. Any changes in resolution will change the 
resolution of all configuration parameters for this process value as well.
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Parameter list - read only

Table 7-7 Key functions - read only
Key Function

Exit parameter list
No functionality
No functionality
No functionality

Parameter list - editable
The help texts describe the possible adjustments of the respective parameters.

Table 7-8 Key functions - edit
Key Function

Escape the view without changing the value.
Select the option above.
Select the option below.
Confirm selected option.

Multiselection

Table 7-9 Key functions - multiselection of options
Key Function

Escape the view without changing the value.
Scroll up in the list.
If the uppermost position is selected: highlight Save settings.
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Key Function
Scroll down in the list.
If the lowermost position is selected: highlight Save settings.
Select / deselect option. 

It is possible to select/deselect multiple alarms to be suppressed. The marked alarms will NOT be 
suppressed.
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Parameter assignment 8
8.1 Multipoint calibration

The transmitter provides an additional 20 point piecewise linear calibration table with user 
selectable input value: volume flow, reynolds number or fluid sound velocity. The table can be 
configured for either unidirectional or bidirectional calibration.

Note
Ascending order by reynolds number
The datapoints must be entered in ascending order by reynolds number.
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Point Reynolds number Calibration correction Point Reynolds number Calibration correction
① 47339 1.0050 ⑪ 54231 0.9930
② 94701 1.0060 ⑫ 102932 0.9934
③ 156034 1.0058 ⑬ 141382 0.9942
④ 238385 1.0062 ⑭ 271843 0.9975
⑤ 402304 1.0017 ⑮ 402304 0.9984
⑥ 532765 0.9971 ⑯ 532765 0.9971
⑦ 663226 0.9960 ⑰ 663226 1.0015
⑧ 793687 0.9950 ⑱ 0 0
⑨ 0 0 ⑲ 0 0
⑩ 0 0 ⑳ 0 0

Figure 8-1 User calibration table behavior (bidirectional calibration)
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Point Reynolds number Calibration correction
① 47339 1.0050
② 94701 1.0060
③ 156034 1.0058
④ 238385 1.0062
⑤ 402304 1.0017
⑥ 532765 0.9971
⑦ 663226 0.9960
⑧ 793687 0.9950
⑨ 0 0
⑩ 0 0

Figure 8-2 User calibration table behavior (unidirectional calibration)

8.2 Inputs and outputs
The available configuration of the hardware functionality of input and output is described in the 
following table.

Table 8-1 Hardware and software configuration of the input/output channels
Channel HW configuration

(fixed when ordering)
SW configuration
available to the user

1 Modbus Modbus
2 Current output Current output (0/4-20 mA)
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Channel HW configuration
(fixed when ordering)

SW configuration
available to the user

3 Relay output Status Output:
• Status signals
• Alarm and diagnostics
• Flow direction

4 Output • Frequency output
• Pulse output

7 Digital input Reset totalizer 1
8 Digital input Pause/resume totalizer 1

Current output
Current output configuration
The following process values can be assigned to the current output: 
• Volume flow
• Mass flow
• Flow velocity
• Sound velocity
• Density
• Kinematic viscosity
• Medium temperature
The accuracy specified for the analog output signal applies only within the range 4 to 20 mA. 
Lower limit (4 mA) and upper limit (20 mA) can be assigned to any specific measurement values.
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① Linear control range
② Lower saturation limit
③ Upper saturation limit
④ Lower fault current value
⑤ Recommended setting range for lower fault current
⑥ Recommended setting range for upper fault current
⑦ Measuring range

Figure 8-3 Current limits for NAMUR configuration
The fail safe current output signal can be selected to:
• Lower fault current (defined in the Loop current scale selection)
• Upper fault current (defined in the Loop current scale selection)
• Last valid value (the last process value before the failure occurred)
• Current value (actual measured value)
• Fail-safe value (within the range of 0 mA to 25 mA 1))

Output scaling configuration
Below are four examples describing configuration possibilities for a current output.
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Positive flow with negative scaling

vv

mA

kg /h

100 kg/h
400 kg/h

v v v

① Low flow cut-off
② Upper range value
③ Maximum output current
④ Upper fault current
⑤ Lower range value
⑥ Lower saturation limit
⑦ Span

Current output setting
• Process value = Mass flow
• Direction = Positive
• Loop current scale = 4-20 mA (maximum 25 mA)
• Upper range value = 100 kg/h
• Lower range value = 400 kg/h
• Fail-safe behaviour = Upper fault current
• Low flow cut-off = 25 kg/h
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Positive flow across zero with positive scaling

vv

mA

m3/h

-250 m3/h
1000 m3/h

v vv

① Lower range value
② Low flow cut-off
③ Upper range value
④ Upper saturation limit
⑤ Lower saturation limit
⑥ Lower fault current
⑦ Measuring range

Current output setting
• Process value = Mass flow
• Direction = Bidirectional
• Loop current scale  = 4-20 mA NAMUR
• Upper range value = 1000 m3/h
• Lower range value = -250 m3/h
• Fail-safe behaviour = Upper fault current
• Low flow cut-off = 25 m3/h
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Bidirectional flow across zero with positive scaling

vv

mA

Kg/h

v vv

① Lower range value
② Low flow cut-off
③ Upper range value
④ Upper saturation limit
⑤  Lower saturation limit 
⑥ Lower fault current
⑦ Span

Current output setting
• Process value = Mass flow
• Direction = Bidirectional
• Loop current scale = 4-20 mA US
• Upper range value = 400 kg/h
• Lower range value = -100 kg/h
• Fail-safe behaviour = Minimum current
• Low flow cut-off = 25 kg/h
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Bidirectional flow with symmetrical scaling

vv

mA

Kg/h

v v

v

vv

① Upper range value
② Lower range value
③ Low flow cut-off
④ Upper fault current
⑤ Upper saturation limit
⑥ Lower saturation limit
⑦ Span

Current output setting
• Process value = Mass flow
• Direction = Bidirectional (Symmetric)
• Loop current scale = 4-20 mA NAMUR
• Upper range value = 400 kg/h
• Lower range value = 100 kg/h
• Fail-safe behaviour = Upper fault current
• Low flow cut-off = 25 kg/h

Pulse output
The pulse output function supplies pulses equivalent to a configured amount of accumulated 
volume or mass. The pulse width is configured and the pulse repetition is proportional to the 
selected flow rate.

Pulse repetition
Pulse repetition is calculated as follows:
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Example
• Pulse output configuration (channels 2 to 4)

– Operation mode = Pulse output
– Process value = Mass flow
– Amount per pulse = 1 kg
– Pulse width = 1 ms

• Measured mass flow value = 10 kg/s (constant)
Result:
• Pulse repetition = 100 ms
• Output frequency = 10 pulses per second with a pulse width of 1 ms
• Remaining time between pulses is 99 ms

Note
Pulse width must be selected with the view that remaining time is always greater than pulse 
width at the highest measured flow.

Frequency output
The frequency output function supplies a frequency (50% duty cycle) proportional to the 
selected process value.
Frequency is calculated as follows:

Example
This example shows how to calculate the output frequency for any measured flowrate:
Frequency output configuration:
• Operation mode = Frequency output (Channel 2 to 4)
• Process value = Mass flow
• Direction = Positive
• Frequency value high = 12 kHz
• Frequency value low = 2 kHz
• Upper range value = 15 kg/s
• Lower range value = 5 kg/s
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Measured mass flow value = 7.5 kg/s (constant)
Result:
● Frequency = 4.5 kHz

Note
The connected equipment must be capable of registering the full range of frequencies 
configured.

Status output
The status output can be used to show alarm status and it can be signaled on Status output or 
Relay output.

Note
Flow direction warning
The limit function for the current output can be used to signal the flow direction by setting the 
Lower warning limit for the Process value to 0. A warning will occur in case of negative flow.
This warning can be output on the status ouput if Status mode is set to Alarm item and the 
Process alarms (1) [relevant process value] below warning limit is selected.

Depending on the Status mode setting, multiple alarms can be signaled on the output and 
selected from the alarm class or the alarm item lists.
• Alarm class: Alarm will be signaled if alarm within the selected alarm class occurs. 
• Alarm item:  Alarm will be signaled if selected alarm item occurs. It is possible to select 

multiple  alarms to be signaled.
Note
Alarm class / NAMUR status signals
The options depend on the setting selected in Staus icons, either NAMUR status signals or 
Alarm class (Siemens Standard).

8.2.1 Digital input

Digital input
If the input signal is activated with a logical signal (15 to 30 V DC) and the Polarity is set to Active 
high level, the meter carries out an activity selected in the menu Input function:
• Reset totalizer 1 on channel 7
• Pause/resume totalizer 1 on channel 8
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Note
Changing polarity
Changing the polarity triggers the signal input to executes the parameterized function.
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Service and maintenance 9
9.1 Basic safety notes

9.1.1 Impermissible repair of the device

WARNING
Impermissible repair of the device
• Repair must be carried out by Siemens authorized personnel only.

9.2 Recalibration
Siemens offers to recalibrate the system.  

Note
For recalibration the transmitter must always be returned with the sensor

Note
SensorFlash
For sensor recalibration the SensorFlash memory unit must always be returned with the sensor.

Cleaning the enclosure
• Clean the outside of the enclosure with the inscriptions and the display window using a cloth 

moistened with water or a mild detergent.
• Do not use any aggressive cleansing agents or solvents, e.g. acetone. Plastic parts could be 

damaged. The inscriptions could become unreadable.

9.3 Maintenance and repair work

9.3.1 Maintenance
The device is maintenance-free. However, a periodic inspection according to pertinent directives 
and regulations must be carried out.   
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An inspection can include check of:
• Ambient conditions
• Seal integrity of the process connections, cable entries, and cover screws
• Reliability of power supply, lightning protection, and grounds
• Coupling compound mating the sensors to the pipe surface

9.3.2 Service and maintenance information
Service and maintenance information is information about the condition of the device used for 
diagnostics and service purposes.   

Maintenance information parameters
The basic maintenance information parameters are:
• Identification

– Order number
– Long tag
– Descriptor
– Location
– Installation date
– Product name
– Hardware and firmware versions 

• Condition and setup
– Peak values
– Signal monitoring
– Temperature monitoring
– Monitoring of inputs and outputs
– Operating time
– Parameter change log
– FW update log
– Diagnostic log

Service information parameters
• Operating time total
• Operating time

Service and maintenance
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• Transmitter hardware version
• Display module hardware version

9.4 Return procedure
To return a product to Siemens, see Returns to Siemens (www.siemens.com/returns-to-
siemens).
Contact your Siemens representative to clarify if a product is repairable, and how to return it. 
They can also help with quick repair processing, a repair cost estimate, or a repair report/cause 
of failure report.

NOTICE
Decontamination
The product may have to be decontaminated before it is returned. Your Siemens contact 
person will let you know for which products this is required.

See also
Decontamination declaration (https://www.siemens.com/sc/declarationofdecontamination)

9.5 Disposal
  Devices described in this manual should be recycled. They may not be dis‐

posed of in the municipal waste disposal services according to the Directive 
2012/19/EC on waste electronic and electrical equipment (WEEE).
Devices can be returned to the supplier within the EC and UK, or to a locally 
approved disposal service for eco-friendly recycling. Observe the specific 
regulations valid in your country.
Further information about devices containing batteries can be found at: 
Information about battery / product return (WEEE) (https://
support.industry.siemens.com/cs/document/109479891/)
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Diagnostics and troubleshooting 10
10.1 Introduction

This chapter describes various deviations from normal operation and lists suggested remedy 
actions.
This chapter is To Be Determined.

10.2 Device status icons
Messages are shown in the display. 
• In the operation view the alarms are shown as a combination of symbol and text in the lower 

line of the display. If several diagnostic messages are active at the same time, the most critical 
is shown.

• In the alarm list view all active alarms are shown as a list. The alarm list combines a symbol, 
text and an alarm ID number. The most recent alarm is shown on top of the list. The alarm list 
view can also be accessed via Active diagnostic events.

• In the alarm history view the most recent alarms (up to 100) are listed. The alarm history log 
can be viewed in Diagnostic log. The alarm history log can be reset in Reset log.

Characteristics of messages
The device provides two types of alarm formats, Siemens standard alarm classes and NAMUR 
status signals, selected in Status icons. 
The following tables summarize the two types of alarm formats in an overview. 
The sequence of the symbols corresponds to the priority of the messages, beginning with the 
most critical.

Siemens standard alarm classes
Icon Priority 

level
Name Description

1 Maintenance failure • Maintenance alarm: maintenance demanded immediately
• Measurement values are not valid

5 Maintenance warning • Maintenance warning 
• Measured signal still valid

6 Maintenance required • Maintenance required
• Measured signal still valid
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Icon Priority 
level

Name Description

3 Process value error • Process value has reached an alarm limit

3 Process value warning • Process value has reached a warning limit

2 Function check • Change of configuration, local operation, or substitute value entered
• Output signals are temporarily invalid

NAMUR status signals
Icon Priority 

level
Name Description

1 Failure • Failure
• Invalid output signal

3 Out of specification • Out of specification
• Device will still work, but output signals may be invalid

4 Maintenance required • Maintenance request
• Measured signal still valid

2 Function check • Function check
• Output signal temporarily invalid

Info icons
Icon Name Description

Read only • Write access disabled
• Indicate read only parameters

Data exchange • Device is communicating

10.3 Fault codes and corrective actions

10.3.1 Alarm messages
Alarms and system messages support both Siemens standard alarm classes and NAMUR status 
signals.
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In the following tables the alarm IDs (identification numbers) are listed along with possible 
causes and directions for corrective action.
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Technical specifications 11
Note
Device specifications
Siemens makes every attempt to ensure the accuracy of these specifications but reserves the 
right to change them at any time.

11.1 Power
Table 11-1 Power supply   
Description Specification
Supply voltage • 100 to 240 V AC +10 / -10%, 47 to 63 Hz

• 11.5 to 28 V DC +10 / -10%
Power consumption • AC = 20 VA

• DC = 10 W
Fluctuation • Transient overvoltages up to the levels of over‐

voltage category II
• Temporary overvoltages occurring on mains 

supply only
Reverse polarity protection (y / n) Y
Galvanic isolation 3000 V AC

11.2 Inputs
Table 11-2 Digital input
Description Channel 7
Load 15 to 30 V DC, Rin 7 kOhm
Functionality • Reset totalizer

Table 11-3 Digital input 
Description Channel 8
Load 15 to 30 V DC, Rin 7 kOhm
Functionality • Start/Stop totalizer
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11.3 Outputs
Table 11-4 Current output
Description Channel 2
Signal range 4 to 20 mA
Resolution 0.4 μA
Load • Ex i: <470 Ω (HART ≥ 230 Ω)

• Non-Ex: <770 Ω (HART ≥ 230 Ω)
Time constant (adjustable) 0.0 to 100 s
Fault current
Measurement range (mA)
Lower fault current (mA)
Upper fault current (mA)

4 - 20 NAMUR
3.8 - 20.5
3.5
22.6

4 - 20 US 
4.0 - 20.8
3.75
22.6

Customized fail-safe mode • Last valid value
– Lower fault current
– Upper fault current

• Fail-safe value
• Current value

Galvanic isolation All inputs and outputs are galvanically isolated PELV circuits with 60 V DC isolation from each 
other and ground.
Maximum test voltage: 500 V AC

Cable Standard industrial signal cable with up to 3 twisted pairs with overall screen can be connected 
between the transmitter and the control system. Individual pair or overall screen is optional 
depending on user requirements.

Voltage range 14 to 30 V DC (passive)

11.4 Construction
Table 11-5 Designated use     
Description Specification
Measurement of process medium • Fluid Group 1 (suitable for dangerous fluids)

• Aggregate state: Paste/light slurry, liquid and gas

Table 11-6 System design   
Description Specification
Measuring principle Ultrasonic
System architecture Wall mount housing with all functions integrated in a single pc 

board
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Device design

Table 11-7 Wall mount housing transmitter design   
Description Specification
Dimensions See Dimension drawings (Page 81) 
Weight Transmitter: 1.27 kg +/- 0.09 kg (2 lbs 8.8 oz)
Design Wall mount housing
Material Plastic
Ingress protection IP65 NEMA 4X to EN/IEC 60529
Mechanical load 18 to 1000 Hz random, 3.17 g RMS, in all directions, to EN/IEC 

68-2-36

Torques

Table 11-8 Installation torques   
Description Torque (Nm)
Cable gland to housing (Siemens 
supplied, metric, NPT)

10

11.5 Operating conditions
Table 11-9 Basic conditions   
Description Specification
Ambient temperature
(Humidity max. 90 %)

Operation: -10 °C to +50 °C (14 °F to +122 °F)

Ambient temperature
(Humidity max. 90 %)

Storage: -20 °C to +60 °C (-4 °F to +140 °F)

Climate class DIN 60721-3-4
Altitude Up to 2000 m (6560 ft)
Relative humidity 95 %
Bump resistance On request
Shock resistance On request
Thermal shock On request
Vibration resistance On request
EMC performance • Emission

• Immunity
• EN 55011 / CISPR-11
• EN/IEC 61326-1 (Industry)

Table 11-10 Process medium conditions
Description Specification
Process medium temperature (Ts) (min to max) -50 °C to +200 °C (-58 °F to 492 °F)
Process medium viscosity Non-compressible liquids
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11.6 Approvals
UL 61010-1 3rd Edition CAN/CSA-C22.2 No. 61010-1, 3rd Edition EN61010-1: 2010

11.7 SensorFlash
Table 11-11 SensorFlash     
Description Specification

SD card (S-300u) SD card (Class 4 with adapter)
Capacity 4 GB 4 GB
File system support FAT32 / 8.3 FAT32 / 8.3
Temperature range
Operation:
Storage:

-40 °C to +85 °C (-40 °F to 185 °F)
-40 °C to +100 °C (-40 °F to 212 °F)

-25 °C to +85 °C (-13 °F to 185 °F)
-40 °C to +85 °C (-40 °F to 185 °F)

Note
SensorFlash functions support
Only the supplied 4 GB SD cards are supported for backup, restore, logging, and firmware update.
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Dimension drawings 12
12.1 Dimension drawing
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Replacement parts 13
13.1 AC Transmitter exploded view

Replaceable parts

① Enclosure cover w/screws and display - A5E38846901
② Cover with screws - A5E41693888 for AC power supply  / A5E41693889 for DC power supply
③ AC power supply - 7ML18301MD / DC power supply - 7ML18301ME
④ Main board assembly with SD card and firmware - A5E41693884
⑤ SensorFlash Micro SD - A5E38288507
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Note
It is recommended that when replacing the transmitter main board or display board ensure to 
remove original SD-card from transmitter and re-install after new modules have been installed 
in order to recall site parameters.

The following components are not shown:
• Connector plugs
• Power and I/O plugs with Right angle connectors for sensor cables - A5E41693892
• Gland kit - A5E41693895
• Spare battery - A5E41372210
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Modbus communication A
A.1 Modbus addressing model

The device allows read/write access to the following standard Modbus RTU data holding register 
blocks:
• Holding registers (ref. 4x address range)
The minimum value of a writable holding register can be read by adding 10000 to the Modbus 
address of the register.
The maximum value of a writable holding register can be read by adding 20000 to the Modbus 
address of the register.
The default value of a writable holding register can be read by adding 30000 to the Modbus 
address of the register.

A.2 Modbus function codes
This device supports following function codes: 3, 8 and 16.
Function codes 3 and 16 are used for accessing registers, max. 16 registers per read/write 
request is accepted.
Function code 8 is used for reading Modbus communication diagnostic information.
Below the various function code are described.

Function code 3 (Read holding registers)
General exceptions:
• Requesting less than 1 or more than 16 registers => Exception 3 (Illegal data value)
• Requesting invalid start address or start address with invalid quantity => Exception 2 (Illegal 

data address)

Application exceptions:
• Application errors; min/max limit of parameter exceeded; or parameter write-protected => 

Exception 4 (Slave device error)

Holes/register alignment:
• The read command always returns data if no exception is given.
• Holes in the holding register map return value zero in all bytes. E.g. reading 2 registers 

starting at 4:0004 above will result in 2 bytes of "float B" followed by 2 zeroes.

SITRANS FST020 IP65 (NEMA 4X)
Operating Instructions, 05/2022, A5E41425845-AC 85



Function code 3 example
Query
Slave address 1 byte
Function 1 byte
Starting Address Hi 1 byte
Starting Address Lo 1 byte
Quantity of Registers Hi 1 byte
Quantity of Registers Lo 1 byte
CRC 2 bytes

Response
Slave address 1 byte
Function 1 byte
Byte count 1 byte
Register Value Hi 1 byte
Register Value Lo 1 byte
: :
Register Value Hi 1 byte
Register Value Lo 1 byte
CRC 2 bytes

Example: Read absolute massflow (address 3000)
Query: 1,3,11,184,0,2,70,10
Slave address  = 1 (0x01)
Function = 3 (0x03)
Starting Address Hi, Lo = 11, 184 (0x0B,0xB8)
Quantity of Registers Hi , Lo = 0, 2 (0x00,0x02) 
CRC  = 70,10 (0x46, 0x0A)
Starting address 0x0BB8 = 3000
Quantity of registers = 0x0002 = 2
Response: 1,3,4,64,195,82,139,98,200
Slave address  = 1 (0x01)
Function = 3 (0x03)
Byte Count  = 4 (0x04)
Register 1 - Register Value Hi, Lo = 64, 195 (0x40, 0xC3)
Register 2 - Register Value Hi, Lo = 82, 139 (0x52,  0x93)
CRC  = 98,200 (0x62, 0xC8)
Absolute mass flow = 0x40C35293 = 6.10383 kg/sec
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Function code 16 (Write multiple registers)
General exceptions
• Writing less than 1 or more than 16 registers => Exception 3 (Illegal data value)
• If ByteCount is not exactly 2 times NoOfRegisters => Exception 3 (Illegal data value)
• Requesting invalid start address or start address with invalid quantity => Exception 2 (Illegal 

data address)

Application exceptions:
• Application errors; min/max limit of parameter exceeded; or parameter write-protected => 

Exception 4 (Slave device error)
• Application errors include writing to ReadOnly holding registers

Holes/register alignment:
• If start-address is not the start of a mapped holding register => Exception 2 (Illegal data 

address)
• Writing to holes is allowed (ie ignored - and no exception occurs) - except for the condition 

described above
• If the end address is only part of a mapped holding register item (e.g. one half of a float 

value), the action depends on the data type. Writing parts of all data types => Exception 4 
(Slave device error)

Function code 16 example
Query
Slave address 1 byte
Function 1 byte
Starting Address Hi 1 byte
Starting Address Lo 1 byte
Quantity of Registers Hi 1 byte
Quantity of Registers Lo 1 byte
Byte Count 1 byte
Registers Value Hi 1 byte
Registers Value Lo 1 byte
: :
Registers Value Hi 1 byte
Registers Value Lo 1 byte
CRC 2 bytes

Response
Slave address 1 byte
Function 1 byte
Starting Address Hi 1 byte
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Starting Address Lo 1 byte
Quantity of Registers Hi 1 byte
Quantity of Registers Lo 1 byte
CRC 2 bytes

Example: Set baud rate to 115200 baud (address 529)
Query: 1,16,2,17,0,1,2,0,5,70,210
Slave address  = 1 (0x01)
Function = 16 (0x10)
Starting Address Hi, Lo = 2, 17 (0x02,0x11)  
Quantity of Registers Hi, Lo = 0, 1 (0x00,0x01)
Byte Count  = 2 (0x02)
Registers Value Hi, Lo = 0, 5 (0x00,0x05)
CRC  = 70,10 (0x46, 0x0A)
Starting address 0x0211 = 529
Number of registers = 0x0001 = 1
Data 0x0005 = (115200 = value 5)
Response: 1,16,2,17,0,1,80,116
Slave address  = 1 (0x01)
Function = 16 (0x10)
Starting Address Hi, Lo = 2, 17 (0x02,0x11)
Quantity of Registers Hi, Lo = 0, 1 (0x00,0x01) 
CRC = 80,116 (0x50, 0x74)

Function code 8 (Diagnostics)
Modbus function code 8 provides a series of tests for checking the communication system 
between a client (Master) device and a server (Slave).
The following diagnostics functions are supported:

Sub-
func‐
tion 
code 
(Dec)

Name Description

00 Return Query Data The data passed in the request data field is to be returned 
(looped back) in the response.

10 Clear Counters and Diagnostic 
Register

Clears all counters and the diagnostic register. Counters are 
also cleared upon power–up.

11 Return Bus Message Count The response data field returns the quantity of messages that 
the remote device has detected on the communications sys‐
tem since its last restart, clear counters execution, or power–
up.

12 Return Bus Communication Er‐
ror Count

The response data field returns the quantity of CRC errors en‐
countered by the remote device since its last restart, clear 
counters execution, or power–up.
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Sub-
func‐
tion 
code 
(Dec)

Name Description

13 Return Bus Exception Error 
Count

The response data field returns the quantity of MODBUS ex‐
ception responses returned by the remote device since its last 
restart, clear counters execution, or power–up.

14 Return Slave Message Count The response data field returns the quantity of messages 
broadcast or addressed to the remote device that the remote 
device has processed since its last restart, clear counters exe‐
cution, or power–up.

15 Return Slave No Response 
Count

The response data field returns the quantity of messages ad‐
dressed to the remote device for which it has returned no 
response (neither a normal response nor an exception re‐
sponse), since its last restart, clear counters execution, or 
power–up.

16 Return Slave NAK Count The response data field returns the quantity of messages ad‐
dressed to the remote device for which it returned a Negative 
Acknowledge (NAK) exception response, since its last restart, 
clear counters execution, or power–up.

17 Return Slave Busy Count The response data field returns the quantity of messages ad‐
dressed to the remote device for which it returned a Slave 
Device Busy exception response, since its last restart, clear 
counters execution, or power–up.

18 Return Bus Character Overrun 
Count

The response data field returns the quantity of messages ad‐
dressed to the remote device that it could not handle due to a 
character overrun condition, since its last restart, clear coun‐
ters execution, or power–up.

20 Clear Overrun Counter and Flag Clears the overrun error counter and resets the error flag.

Function code 8 example
Query
Slave address 1 byte
Function 1 byte
Sub-function Hi 1 byte
Sub-function Lo 1 byte
Data Hi 1 byte
Data Lo 1 byte
: :
Data Hi 1 byte
Data Lo 1 byte
CRC 2 bytes

Response
Slave address 1 byte
Function 1 byte
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Sub-function Hi 1 byte
Sub-function Lo 1 byte
Data Hi 1 byte
Data Lo 1 byte
: :
Data Hi 1 byte
Data Lo 1 byte
CRC 2 bytes

Example: Read Return Slave Message Count (address 529)
Query: 1,8,0,14,0,0,129,200
Slave address  = 1 (0x01)
Function = 8 (0x08)
Sub-function Hi, Lo = 0, 14 (0x00,0x0E)
Data Hi, Lo = 0, 0 (0x00,0x00)
CRC  = 129,200 (0x81, 0xC8)
Sub-function 0x000E = 14 = Read Return Slave Message Count
Response: 1,8,0,14,0,97,64,32
Slave address  = 1 (0x01)
Function = 8 (0x08)
Sub-function Hi, Lo = 0, 14 (0x00,0x0E)
Data Hi, Lo = 0, 97 (0x00,0x65)
CRC  =  64,32 (0x41, 0xE3)
Read Return Slave Message Count = 0x0065 = 97 message received

A.3 Changing Modbus communication settings
Changing communication parameters, for example Baud Rate, Modbus Parity Framing or Bus 
Address effects the Modbus communication as follows:
• The new settings have effect only after a reset, either by restarting the device or writing the 

value 1 to Modbus address 600 Restart communication. 
• The new settings will not have effect until the Modbus driver has responded to any ongoing 

Modbus request.
NOTICE
Setting addresses in a multidrop network
It is recommended NOT to use the default address in a multi-drop network. When setting 
device addresses, make sure that each device has a unique address. Replication of addresses 
may cause abnormal behavior of the entire serial bus and make the master unable to 
communicate with all slaves on the bus.  
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A.4 Modbus communication
Table A-1 General Modbus settings   
Modbus 
register

Data type / 
Size in 
bytes

Parameter Description Default 
value 
[units]
(units
register)

Value range / 
Setting options

Access 
level

8291 Unsigned / 
2

Restart com‐
munication

Restarts the communication using 
configured slave address, baud rate 
and parity/framing.

- • 0: Cancel
• 1: Restart

Write only

8005 Unsigned / 
2

Slave address 
(HW)

DIP switch setting on the transmitter 
cassette. Address is used if DIP switch 
is set to a value > 0.

- - Read only

8297 Unsigned / 
2

Slave address 
(SW)

Software address of Modbus inter‐
face. Address is used if switch is set to 
0.

1 1 - 147 Read / 
write

8298 Unsigned / 
2

Baud rate Baud rate of Modbus interface. 19200 Bit/s • 0: 9600 Bit/s
• 1: 19200 

Bit/s
• 2: 115200 

Bit/s
• 3: Reserved
• 4: 38400 

Bit/s
• 5: 57600 

Bit/s
• 6: 76800 

Bit/s
• 7: 1200 Bit/s
• 8: 2400 Bit/s
• 9: 4800 Bit/s

Read / 
write

8299 Unsigned / 
2

Parity and fram‐
ing

Parity and framing of the Modbus 
communication interface.

Even pari‐
ty, 1 stop

• 0: Even pari‐
ty, 1 stop

• 1: Odd pari‐
ty, 1 stop

• 2: No parity, 
2 stops

• 3: No parity, 
1 stop

Read / 
write
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A.5 Coil configuration
The device provides 20 coil definitions which can be configured. 

Table A-2 Coil configuration   
Modbus 
register

Data type / 
Size in bytes

Parameter Description Default value 
[units] 1
(units regis‐
ter)

Value range / 
Setting options

Access lev‐
el

10300 Unsigned / 2 Modbus coil ad‐
dress 1

Specifies the coil address with 
which the following bit coded 
register value is accessible. 
The register and bit(s) are 
specified by Modbus coil regis‐
ter 1and Modbus coil bitmask 
1

1 0 - 65535 Read / write

10301 Unsigned / 2 Modbus coil reg‐
ister 1

Specifies the Modbus register 
whose value is checked 
against Modbus coil bitmask 1 
to determine the coil value 
(false or true). A register value 
of 65535 specifies that this coil 
mapping is undefined.

Undefined 0 - 65535 Read / write

10302 Unsigned / 4 Modbus coil bit‐
mask 1

Bit mask which is compared 
against the register value 
specified with Modbus coil reg‐
ister 1 to determine the coil 
value. If any bit of the register 
value is set which is also set in 
the bit mask then the coil value 
is true, otherwise the coil is 
false.

0 0 - 4294967295 Read / write

10304 Unsigned / 2 Modbus coil 
length 1

Output parameter that in‐
forms about the size in bytes of 
the parameter that is specified 
by Modbus coil address 1. 
Could be used to identify the 
relevant bits of the Modbus 
coil bitmask 1

-  Read only

10305 Unsigned / 2 Modbus coil ad‐
dress 2

Specifies the coil address with 
which the following bit coded 
register value is accessible. 
The register and bit(s) are 
specified by Modbus coil regis‐
ter 2 and Modbus coil bitmask 
2

2 0 - 65535 Read / write

10306 Unsigned / 2 Modbus coil reg‐
ister 2

Specifies the Modbus register 
whose value is checked 
against Modbus coil bitmask 2 
to determine the coil value 
(false or true). A register value 
of 65535 specifies that this coil 
mapping is undefined.

Undefined  Read / write
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Modbus 
register

Data type / 
Size in bytes

Parameter Description Default value 
[units] 1
(units regis‐
ter)

Value range / 
Setting options

Access lev‐
el

10307 Unsigned / 4 Modbus coil bit‐
mask 2

Bit mask which is compared 
against the register value 
specified with Modbus coil reg‐
ister 2 to determine the coil 
value. If any bit of the register 
value is set which is also set in 
the bit mask then the coil value 
is true otherwise false.

0 0 - 4294967295 Read / write

10309 Unsigned / 2 Modbus coil 
length 2

Output parameter that in‐
forms about size in bytes of pa‐
rameter that is specified by 
Modbus coil address 2. Could 
be used to identify the rele‐
vant bits of the Modbus coil 
bitmask 2

-  Read only

...
10399 Unsigned / 2 Modbus coil 

length 20
Output parameter that in‐
forms about the size in bytes of 
the parameter that is specified 
by Modbus coil address 20. 
Could be used to identify the 
relevant bits of the Modbus 
coil bitmask 20

-  Read only

1 If default value is "-" the command "Set to default" will not set this parameter to default.  

A.6 Modbus register mapping
The device provides the possibility to map each existing parameter to a freely chosen Modbus 
register for communication purposes over channel 1.
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The device provides means to remap 20 Modbus registers.

Table A-3 Modbus register mapping   
Modbus 
register

Data type / 
Size in 
bytes

Parameter Description Default value 
[units]
(units regis‐
ter)

Value range / 
Setting op‐
tions

Access 
level

10448 Unsigned / 4 Enable mapping Activation/deactivation of 
the register mapping. A set 
bit means that the mapping 
pair is activated, a cleared bit 
that the mapping pair is de‐
activated.
Bit 0:
Requested register 1 / Target 
register 1
…
Bit 19:
Requested register 20 / Tar‐
get register 20

0 0 - 1048575 Read / 
write

10450 Unsigned / 2 Register 1 source Modbus register that ap‐
pears within Modbus request 
is redirected to the parame‐
ter specified by Target regis‐
ter 1

65535 0 - 65535 Read / 
write

10451 Unsigned / 2 Register 1 target Register of an existing prod‐
uct parameter to which a 
Modbus request is redirected

65535 0 - 65535 Read / 
write

...
10488 Unsigned / 2 Register 20 source Modbus register that ap‐

pears within Modbus request 
is redirected to the parame‐
ter specified by Target regis‐
ter 20

65535 0 - 65535 Read / 
write

10489 Unsigned / 2 Register 20 target Register of an existing prod‐
uct parameter to which a 
Modbus request is redirected

65535 0 - 65535 Read / 
write
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A.7 Integer byte order
The device is able to adjust the byte order of integer values. 

Table A-4 Integer byte order   
Modbus 
register

Data type / 
Size in 
bytes

Parameter Description Default value 
[units]
(units regis‐
ter)

Value range / 
Setting op‐
tions

Access 
level

8295 Unsigned / 2 Integer order byte The integer byte order used 
in Modbus messages.
0: MSB - LSB (big endian)
1: LSB - MSB (little endian)
MSB = most significant byte / 
high byte
LSB = least significant byte / 
low byte

MSB - LSB (big 
endian)

0 - 1 Read / 
write

A.8 Float byte order
The device is able to adjust the byte order of floating-point values. 

Table A-5 Float byte order    
Modbus 
register

Data type / 
Size in 
bytes

Parameter Description Default value 
[units]
(units regis‐
ter)

Value range / 
Setting op‐
tions

Access 
level

8296 Unsigned / 2 Float byte order The float byte order used in 
Modbus messages.
0: 1-0-3-2
1: 0-1-2-3
2: 2-3-0-1
3: 3-2-1-0
The first mentioned byte is 
the first byte sent. 
Byte 3 corresponds to the 
left-most byte (MSB) of a 32 
bit floating point number in 
big endian format, byte 0 to 
the right-most byte

3-2-1-0 0 - 3 Read / 
write
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A.9 Modbus function codes
Table A-6 General Modbus settings   
Function code Command text Description
01 Read Coils Reads the status of single bit(s)
02 Read Discrete Inputs Reads the status of single input bit(s)
03 Read Holding Registers Reads the binary content of multiple 16-bit registers
04 Read Input Registers Reads the binary content of multiple 16-bit registers
05 Write Single Coil Writes a single on/off bit
06 Write Single Register Writes the binary content of single 16-bit register
07 Read Exception Status Delivers the global alarm status of the device
08 Diagnostics Provides a series of tests for checking the communication system
15 Write Multiple Coils Writes multiple on/off bits
16 Write Multiple Registers Writes the binary content of multiple 16-bit registers
17 Report Slave ID The device will respond to a Report Slave ID command (com‐

mand 17) request from the master by giving information about 
device type, vendor, and revision level

23 Read/Write Multiple Registers Combined Write Multiple Registers / Read Holding Registers call

Function code 7 (Read exception status) 
The device provides the content of the parameter Global alarm status as exceptions. 

Function code 8 (Diagnostics) 
The diagnostics function provides means for checking the communication between MODBUS 
master and slave. The function uses a sub-function code to select the functionality.
The following sub-function codes are supported:

Sub-function code Name Description
0 Return query data The data passed in the request data field will be returned (looped 

back) in the response. The entire response message should be 
identical to the request.

1 Restart communications option After having restarted the communication, select the baudrate, 
framing or Modbus address to get access to the device again.

Function code 17 (Report Slave ID) 
The transmitter will respond to a Report Slave ID request from the master by giving information 
about device type, vendor, and firmware version in a format as shown:
Response

Slave address 1 byte  
Function code 1 byte 17
Byte count 1 byte 62
Slave ID 1 byte Sensor device type

0: SITRANS FS
Run indicator 1 byte 255: Running
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Manufacturer name 12 bytes SIEMENS
Product name 32 bytes SITRANS F
Product firmware 
version

16 bytes -

CRC 2 bytes  

A.10 Access control
Access control manages whether the Modbus master is allowed to modify device parameters. 
Reading of parameters is always possible. The general access control rules are:
• The Modbus interface has an access level that can be changed by providing PIN information 

via the Modbus register 8292 (User PIN) or 8293 (Expert PIN).
• Each parameter has a protection level assigned that specifies the required access level to 

modify the parameter via the Modbus interface.
• If the access level of the Modbus interface is lower than the protection level of the parameter 

that is desired to be modified, then the attempt to modify the parameter is rejected by the 
device.

Table A-7 Access control   
Access level Description
Read only The Modbus master is not able to modify the device configuration (setup parameters).

The Modbus master is only able to execute the command, to reset PINs.
This is the default level of the Modbus interface.

User The Modbus master has to provide the correct user PIN with Modbus register 8292 to reach this access 
level.
The Modbus master is able to modify a subset of the device configuration.

Expert The Modbus master has to provide the correct expert PIN with Modbus register 8293 to reach this access 
level.  The Modbus master is able to modify the configuration of the device.

If an incorrect user PIN or an incorrect expert PIN is entered, or if the device does not receive any 
request within 10 minutes, the device resets the access level to read only. 
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Product Documentation and support B
B.1 Product documentation

Process instrumentation product documentation is available in the following formats: 
• Certificates (http://www.siemens.com/processinstrumentation/certificates)   
• Downloads (firmware, EDDs, software) (http://www.siemens.com/processinstrumentation/

downloads) 
• Catalog and catalog sheets (http://www.siemens.com/processinstrumentation/catalogs) 
• Manuals (http://www.siemens.com/processinstrumentation/documentation) 

You have the option to show, open, save, or configure the manual.
– "Display": Open the manual in HTML5 format
– "Configure": Register and configure the documentation specific to your plant
– "Download": Open or save the manual in PDF format
– "Download as html5, only PC": Open or save the manual in the HTML5 view on your PC

You can also find manuals with the Mobile app at Industry Online Support (https://
support.industry.siemens.com/cs/ww/en/sc/2067). Download the app to your mobile device 
and scan the device QR code.

Product documentation by serial number
Using the PIA Life Cycle Portal, you can access the serial number-specific product information 
including technical specifications, spare parts, calibration data, or factory certificates.

Entering a serial number
1. Open the PIA Life Cycle Portal (https://www.pia-portal.automation.siemens.com).
2. Select the desired language.
3. Enter the serial number of your device. The product documentation relevant for your device 

is displayed and can be downloaded.
To display factory certificates, if available, log in to the PIA Life Cycle Portal using your login or 
register.

Scanning a QR code
1. Scan the QR code on your device with a mobile device.
2. Click "PIA Portal".
To display factory certificates, if available, log in to the PIA Life Cycle Portal using your login or 
register.
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B.2 Technical support

Technical support
If this documentation does not completely answer your technical questions, you can enter a 
Support Request (http://www.siemens.com/automation/support-request). 
For help creating a support request, view this video here (www.siemens.com/opensr). 
Additional information on our technical support can be found at Technical Support (http://
www.siemens.com/automation/csi/service).   

Service & support on the Internet 
In addition to our technical support, Siemens offers comprehensive online services at Service & 
Support (http://www.siemens.com/automation/serviceandsupport).

Contact 
If you have further questions about the device, contact your local Siemens representative at 
Personal Contact (http://www.automation.siemens.com/partner).
To find the contact for your product, go to "all products and branches" and select "Products & 
Services > Industrial automation > Process instrumentation".
Contact address for business unit: 
Siemens AG
Digital Industries
Process Automation
Östliche Rheinbrückenstr. 50 
76187 Karlsruhe, Germany
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SIMATIC PDM C
C.1 Commissioning with SIMATIC PDM

C.1.1 Overview SIMATIC PDM
SIMATIC PDM (Process Device Manager) is a general-purpose, manufacturer-independent tool 
for the configuration, parameter assignment, commissioning, diagnostics and maintenance of 
intelligent field devices and field components. Follow-up installations and additional 
information on SIMATIC PDM are available on the Internet at SIMATIC PDM (https://
www.siemens.com/simatic-pdm).
SIMATIC PDM monitors the process values, alarms and status signals of the device. It allows you 
to display, compare, adjust, verify, and simulate process device data; also to set schedules for 
calibration and maintenance.
For information on, for example, how to install and integrate devices, commission the software, 
see Operating Manual 'Help for SIMATIC PDM'. The manual is delivered with SIMATIC PDM 
software. Once the SIMATIC PDM is installed on your computer you find the manual under: Start 
> All programs > Siemens Automation > SIMATIC > Documentation. Link at our website: 
SIMATIC PDM instructions and manuals (https://support.industry.siemens.com/cs/ww/en/ps/
16983/man).

Note
Field device parameters
• For a list of parameters and additional information, consult section "HMI menu structure 

(Page 115)".
• The field device remains in measurement mode during the time you configure the field 

device.

C.1.2 Check SIMATIC PDM version

Procedure
1. Go to Software downloads (https://www.siemens.com/processinstrumentation/downloads).
2. Check the support page to make sure you have:

– The latest version of SIMATIC PDM
– The most recent Service Pack (SP)
– The most recent hot fix (HF)
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C.1.3 Deactivate buffers when connecting via serial modem

Introduction
This deactivation is required to align SIMATIC PDM with the HART modem when using a 
Microsoft Windows operating systems.
Deactivating buffers is not necessary when connecting via USB.

Condition
• You connect via RS232 (COM1).
• You have administrative rights on your operating system.
• You know the hardware and software requirements SIMATIC PDM installation 

documentation.

Procedure
1. Check the Operating Instructions for SIMATIC PDM for hardware and software requirements.
2. From the computer desktop, click "Start > Control Panel" to begin configuration.
3. Click "System and Security".
4. Select "Device Manager" under "System".
5. Open folder "Ports".
6. Double click the COM Port used by the system to open the properties window.
7. Select the tab "Port Settings".
8. Click the "Advanced" button.

If the "Use FIFO buffers" radio box is selected, click to deselect.

① Deselect "Use FIFO buffers" radio box

9. Click "OK" button to close out.
10.Close all screens.
11.Restart the computer.
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C.1.4 Updating the Electronic Device Description (EDD) or Field Device Integration 
(FDI)

Procedure
1. Check that the EDD or FDI revision match the Firmware revision in the device according to the 

table in section Product compatibility (Page 7).
2. Go to the support page Software downloads (https://www.siemens.com/

processinstrumentation/downloads).
3. Enter the product name in the field "Enter search term...".
4. Download the most current EDD or FDI of your device.
5. Save files to your computer in an easily accessed location.
6. Launch SIMATIC PDM – Device Integration Manager.

From the File menu, click "Read device descriptions from compressed source...".
7. Browse to the compressed EDD or FDI files, select and open it. 
8. Use the "Integration" function to integrate the EDD or FDI into the device catalog. The EDD or 

FDI is now accessible via SIMATIC Manager.
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C.1.5 Adding device to communication network
Before setting the parameters, it is necessary to configure the FS230 project in PDM. 
1. Add the device to SIMATIC Modbus network: 

– Open the project in the process device network view.
– Right click on Networks and select Insert New Object → Communication network.

The Insert Object(s) - <...> dialog box opens.
– Click on Assign Device Type.
– Select the inserted Modbus network in the right window and right-click.
– Select the Object Properties command.
– Enter the device-specific information in the Communication tab of the Properties dialog 

for the Modbus network.

Modbus communication type: Serial or IrDA (infrared)
Serial The interface must be set accordingly on the PC station.
IrDA No additional setting required.

Once the device is within range, it is available for Modbus communication.
Only one infrared device can be coupled to Modbus at a given time. Several devices 
can be coupled under Windows.

Response 
time

General timeout within which the device is allowed to report. If the timeout is too 
long, the communication is slowed. If it is too short, some devices may not be 
found.

Figure C-1 Assigning Modbus device to network
– To check if the correct network and the correct port are assigned to the COM interface, 

double-click the PC object in the right window. Select the COM interface object in HW 
Config, and select the Object Properties menu command in the shortcut menu.

2. Set up the COM interface:
– To insert the Modbus device, select the Modbus network object in the right window and 

right-click. In the displayed shortcut menu, select the Insert New Object → Object 
command. In the displayed dialog box, enter the name of the Modbus device

– To set the device address, select the inserted Modbus device in the right window and right-
click. Select the Object Properties command in the displayed shortcut menu.

– Enter the device-specific information (Modbus address 0-247) in the Communication tab 
of the Properties dialog for the Modbus device.
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– To change the device address, select the inserted Modbus device in the right window and 
then select the Object Properties menu command in the shortcut menu. Select the 
Communication tab in the displayed dialog and enter the new short address.

– Start SIMATIC PDM by double-clicking the newly inserted Modbus device in the right 
window. Select the relevant device in the menu tree (only required for the first call), and 
assign parameters for the device.

Figure C-2 Set COM port

Note
Multiple PCs in one project
If there are several PCs in your project, you have to define one of them as the current one. To do 
this, select the desired PC object in the left window and then select the menu command Options 
→ Define Current PC.

C.1.6 Integrating a HART device in a HART modem network

Figure C-3 HART modem
The following describes how to integrate a HART device in a HART modem network.

Requirements
• A project has been created.
• An access point of the computer is set to the COM port to which the HART modem network 

is connected.
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Integrating a HART device in a HART modem network
1. Open the project in the process device network view.
2. Right-click the "Networks" object in the tree structure. In the shortcut menu that opens, select 

the menu command Insert New Object > Communication network. The "Insert Object(s) - 
<...>" dialog box opens.

3. Click the "Assign Device Type" button.
The "Insert Object(s) - Assign Device Type" dialog box opens. You can find additional 
information in the section "Insert Object - Assign Device Type" dialog box.

4. To set the network properties, select the inserted HART modem network in the right window 
and right-click. Select the Object Properties command in the displayed shortcut menu.

5. Enter the device-specific information in the "Communication" tab of the Properties dialog for 
the HART modem network.
Set the master type (primary or secondary, usually secondary):
Here, you can select the "Prefer 'Long address'" check box.

Modbus communication type: Serial or IrDA (infrared)
Serial The interface must be set accordingly on the PC station.
IrDA No additional setting required.

Once the device is within range, it is available for Modbus communication.
Only one infrared device can be coupled to Modbus at a given time. Several devices 
can be coupled under Windows.

Response 
time

General timeout within which the device is allowed to report. If the timeout is too 
long, the communication is slowed. If it is too short, some devices may not be found.

Figure C-4 Assigning HART device to network
6. To check if the correct network and the correct port are assigned to the COM interface, 

double-click the PC object in the right window. Select the COM interface object in HW 
Config, and select the Object Properties menu command in the shortcut menu.
Note
The COM port is almost always "1" for notebooks. Since most PCs have two COM ports, you 
must specify the port to which the HART modem is connected in this tab. Check whether the 
settings for the FIFO buffer of the COM port are suitable, or immediately use a USB HART 
modem.

7. To insert the HART device, select the HART modem Modbus network object in the right 
window and right-click. In the displayed shortcut menu, select the Insert New Object → 
Object command.
In the displayed dialog box, enter the name of the HART device
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8. To set the device address, select the inserted Modbus device in the right window and right-
click. Select the Object Properties command in the displayed shortcut menu.

9. Enter the device-specific information (Modbus address 0-247) in the Communication tab of 
the Properties dialog for the HART device.
Note
Address with HART
• The short address must be entered for HART devices. This address must correspond to the 

connected HART device. The short address is always "0", unless the device is in the multi-
drop function.

• For a HART interface, enter the long address. This address contains the following device-
specific information:
– Manufacturer
– Device type
– Device name

10.To change the device address, select the inserted HART device in the right window and then 
select the Object properties menu command in the shortcut menu. Select the 
"Communication" tab in the displayed dialog and enter the new short address.
Note
The address must correspond to the connected device. The short address for HART devices is 
always "0" unless the device is in the multi-drop function.

11.Start SIMATIC PDM by double-clicking the newly inserted HART device in the right window. 
Select the relevant device in the menu tree (only required for the first call), and assign 
parameters for the device.

Figure C-5 Set COM port

Note
Multiple PCs in one project
If there are several PCs in your project, you have to define one of them as the current one. To do 
this, select the desired PC object in the left window and then select the menu command Options 
→ Define Current PC.
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C.1.7 Configuring a new device

Note
Configuring device via SIMATIC PDM
Clicking "Cancel" button during an upload from device to SIMATIC PDM will result in some 
parameters being updated.

1. Check that you have the most recent EDD, and if necessary update it. See Updating the 
Electronic Device Description (EDD) or Field Device Integration (FDI) (Page 103).

2. Launch SIMATIC Manager and create a new project for the device. 
3. Open the menu "Device > Operation > Reset > Restore ordered configuration". Select "Yes" 

button and click "OK" to perform a reset to customer ordered settings.
4. After the reset is complete click on “Upload to PG/PC…” to customer ordered settings.
5. Configure the device via the Quick Start wizard. (See Wizard - Quick Start via PDM (Page 108).)

C.1.8 Wizard - Quick Start via PDM
The graphic Quick Start Wizard provides an easy multistep procedure that configures the device 
for a simple application.
Please consult the SIMATIC PDM operating instructions or online help for details on using 
SIMATIC PDM.

Quick start

Note
• The Quick Start wizard settings are inter-related and changes apply only after you click on 

Apply at the end of the wizard to transfer settings to the device.
• Do not use the Quick Start Wizard to modify individual parameters.
• Click on Back to return and revise settings or Cancel to exit the Quick Start.

Launch SIMATIC PDM, open the menu Device → Wizards → Wizard - Quick Start..., and follow the 
steps.
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C.1.9 Wizard - Clamp-On Configuration
Open the menu Device → Wizards → Wizard - Clamp-On Configuration..., and follow the steps.

The clamp-on configuration wizard takes the user through the necessary steps to install the 
sensors to achieve proper operation.

C.1.10 Zero point adjustment
Open the menu Device → Operation → Zero point adjustment, and follow the steps.
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Although the device zero is very stable from the factory the user has the ability to remove any 
residual zero offset that may exist by performing the Zero point adjustment.

C.1.11 Changing parameter settings using SIMATIC PDM
SIMATIC PDM monitors the process values, alarms and status signals of the device. It allows you 
to display, compare, adjust, verify, and simulate process device data; also to set schedules for 
calibration and maintenance.
Parameters in SIMATIC PDM are identified by name and organized into function groups, similar 
to the structure of the local display (HMI). 
Within SIMATIC PDM, parameters can be found in a structured view (which can be accessed 
when the device is offline), or in the PDM menus (when device is online): Device, View, 
Diagnostics.  
See:
• SIMATIC PDM structure view image (Page 112)
• Parameters accessed via PDM menus (Page 112)

Note
• Clicking button "Cancel"  during an upload from device to SIMATIC PDM will result in some 

parameters being updated.
• While the device is in Edit view the output remains active and continues to respond to 

changes in the device.

1. Launch SIMATIC PDM, connect to device, and upload data from device. 
2. Adjust parameter values in the parameter value field then press "Enter" key. The status fields 

read "Changed".
3. Open the Device menu, click "Download to device...".  When complete, use "File > Save" to 

save settings offline. The status fields are cleared.
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C.1.12 SIMATIC PDM structure view image

① Structure view (offline table)
② Value fields

C.1.13 Parameters accessed via PDM menus
Click on "Device", "View", or "Diagnostics" to open the associated PDM menu.

① PDM menus
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PDM menus
Device View Diagnostics
Download to device
Upload to PC/PG

Process values Update diagnostics

Assign address and Tag...
Value comparison...
Object properties...
Calibration log...
Change Log...
Set evice checked...

Start Life List... Alarms
Advanced diagnostics
Receiver signal

Check configuration...
Templates

  

Identification   
Wizards
Operation

  

Setup
Maintenance and diagnostics

  

Communication
Security
Characteristics
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C.1.14 Process variables
1. To compare outputs in real time select View → Process variables to see all process values, 

totalizers and loop current.
2. Verify that the process values show the expected values.

Trend view
Open the menu View → Process variables and click on a Trend view button to monitor the trend 
of one or all process values available at each tab.

SIMATIC PDM
C.1 Commissioning with SIMATIC PDM

SITRANS FST020 IP65 (NEMA 4X)
114 Operating Instructions, 05/2022, A5E41425845-AC



HMI menu structure D
An overview of the HMI menu structure is available for download under this link (https://
support.industry.siemens.com/cs/document/109804533/menu-structure-of-the-sitrans-
fst020-and-sitrans-fst090?dti=0&pnid=24980&lc=en-US).

Note
Visibility of menus/parameters
The visibility of some parameter/menu items depends on previous selections. For example, if 
Frequency is selected on the output, only the frequency setup parameter/menu items are visible. 
The parameter/menu items for setting the current output, pulse output, and status output are 
hidden.
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